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Setting up an X.400 Email System 
 
Using Isode’s M-Switch X.400 (MTA), M-Store (message store) and Xuxa (X.400 test 
email client) products to set up an X.400 email system for local message exchange and 
connection to external X.400 systems. 
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Introduction 

This guide details the process for creating an X.400 based messaging systems using Isode’s M-
Switch X.400 and M-Store products. You’ll test the system using Isode’s Xuxa test/demo user 
agent. M-Switch SMTP is one of a family of email messaging products which comprises: 

• M-Switch SMTP (SMTP Message Transfer Agent) 

• M-Box (POP/IMAP Message Store) 

• M-Switch X.400 (X.400 Message Transfer Agent) 

• M-Store (X.400 Message Store) 

• M-Switch MIXER (message gateway providing conversion between X.400 and Internet 
email according to the MIXER specifications) 

• M-Switch Constrained Networks (Email Messaging for low-bandwidth and/or high-
latency networks) 

• Harrier Web (web based email client) 

M-Switch products are widely deployed in the Government, Military, Intelligence, Civil Aviation 
and EDI markets. 

Use of TLS: Due to UK Export Controls we are unable to provide Evaluation Licenses 
to certain Geographic regions that would allow the use of TLS so this guide will not 

configure any TLS. Should you wish to use TLS please contact your Account Manager 
and if you are located in an approved region we can provide a license (MAC Address 

of Server required) and additional instructions for configuring TLS. 

Objectives 
By the end of this guide you will have: 

1. Created an M-Switch X.400 server with the message configuration held in a Directory 
Server (Isode’s M-Vault LDAP Directory) 

2. Created two X.400 users/mailboxes in an M-Store message store 

3. Exchanged messages between these two users with the Xuxa test/demo user agent 

4. Created a connection to an external X.400 server (optional) 

5. Sent a message to a remote user using that connection (optional) 

You’ll use the MConsole (Message Console) management GUI to set up your system. MConsole is 
Isode's central tool for messaging system Configuration and Operational management for both 
Internet and X.400 Messaging deployments. 

This guide uses the address space “/P=Local/A=Field/C=GB/” to refer to the system being created 
here and “/P=Local/A=Headquarters/C=GB/” to refer to the external X.400 server required for 
steps 4 and 5. For ““/P=Local/A=Headquarters/C=GB/” this guide uses the M-Switch MIXER 
instance set up in the “Isode M-Switch MIXER” evaluation guide. 

The diagram which follows shows the main elements of the system. 
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For the purposes of this evaluation we have assumed this is a "clean" installation of M-Switch 
X.400 on to a physical or virtual machine. If you have previously installed an M-Switch product 
on the hardware or VM you are using for this evaluation, please make sure you have 
completely uninstalled that version before proceeding. 

Using Isode Support 
You will be given access to Isode support resources when carrying out your evaluation. Any 
queries you have during your evaluation should be sent to support@isode.com. Please note that 
access to the Self-Service Portal for web-based ticket submission and tracking is not available to 
evaluators. 
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Preparation 

You should visit www.isode.com/products/supported-platforms.html  to discover which operating 
systems are supported for Isode evaluations. Please note that in addition to the server platforms 
listed, we support the use of Isode servers on Windows 8, Windows 8.1 and Windows 10 for 
simple evaluations and demonstrations. 

Isode Products 
Product downloads are held in a password-protected section of the Isode website. If you have not 
already done so you should apply for a username/password by filling in the form located at 
www.isode.com/evaluate/evalrequest.html. 

Products can be obtained by clicking on the links in the “Download Links” section of the 
Directory evaluation page (www.isode.com/evaluate/evaluate-email.html). The downloads page 
will give installation instructions specific to your platform. 

Product Activation Key 
Isode server products require a valid Product Activation Key from Isode before they will run 
correctly. Keys are issued by Isode Customer Services. If you haven't already been sent a Key when 
requesting access to the evaluation files, please send a message to request one to 
support@isode.com remembering to specify which Isode server products you need a Key for. 

By default, the file you receive needs to be placed in \Isode\etc\ (Windows) or /etc/isode/ (Linux), 
renamed as 'license.dat'. You may have chosen an alternative installation directory when 
installing the software, in which case you will have to place the license file there. 

External X.400 Server Details 
The optional 4th and 5th objectives in this guide assume that you already have access to an external 
X.400 server, which this installation will exchange messages with. This may be a system you have 
previously configured or it may be a system you have set up as part of the Isode “M-Switch 
MIXER” evaluation. 

In either case, if you wish to complete these optional objectives, ensure you have the connection 
details of that external system. 
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Create a Messaging Configuration using MConsole 

In this section you’ll use MConsole to create a Directory Server to hold the messaging system 
configuration. 

Starting MConsole 
In Windows locate the MConsole program icon and select it. On Linux execute the following 
command: 

% /opt/isode/bin/mconsole 

When MConsole starts, click on [Yes] when asked to confirm the encryption of your bind profile. 
Enter a Profile Passphrase when promoted (making a note of this), click on [OK] to submit and 
[OK] again when the encryption confirmation is displayed. 

Image 1: Enter Bind Profile Passphrase 

 

Creating a new Directory Server 
In the Welcome to Message Console screen (Image 2) select the “Create a new DSA and 
Messaging Configuration” option, click [OK] and then provide an Initial Directory User Name 
(Image 3). This can be any name, this guide uses “Messaging Admin”. 

Image 2: MConsole Welcome Screen 
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Image 3: Choose the Initial Directory User’s Name 

 

You now need to choose a top level Directory Server DN for your installation, this can be any 
o="any name", it defaults to "o=messaging". This guide uses "o=Field". Click [Next]. 

Image 4: DIT Structure Configuration 

 

In the Password Configuration screen, set a password and then click [Next]. 

Image 5: Password Configuration 

 

In the next two screens Bind Profile Names and Filesystem Location and Address 
Configuration, use the suggested values and click [Next] through both screens before reaching 
the Confirm Details screen. 
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Click on [Finish] here (Image 6) and the DSA will be created and started. 

Image 6: Confirm Details 

 

Create a New Messaging Configuration 
After the creation of the DSA, MConsole will prompt you to create a new messaging 
configuration. 

Highlight the “o=Field” entry, click [Next] and then select “X.400 MTA (M-Switch X.400)” when 
prompted for a messaging configuration type. 

Image 7: Create a new MHS Configuration 

 

 



Isode 

Evaluation Guide: Setting up an X.400 Email System  Page 9 of 32 

Image 8: Select Messaging Configuration Type 

 

Click [Next] and MConsole will prompt for a Market Segment choice (choose General Purpose), 
in the next two screens accept the defaults for the Hostname (Image 9) and Administrator 
authentication details (Image 10) clicking [Next] through both of these screens. 

Image 9: Hostname 
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Image 10: Administrator Authentication Details 

 

In the X.400 Configuration screen (Image 11), enter your Local X.400 Address Space (in this 
guide we are using /P=Local/A=Field/C=GB/).  

You will also want to create an X.400 Message Store (M-Store) so tick the “Create and X.400 
Message Store for local P7 users” radio button before clicking on [Next]. 

Image 11: X.400 Configuration 

 

Accept the defaults on the Service File Creation screen and then click [Finish]. 
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Image 12: Service File Creation 

 

In the Create Isode Services screen, ensure that M-Switch and M-Store services are selected 
(Image 13) and then click [Finish] to be dropped back into the main MConsole screen. 

Image 13: Create Isode Services 
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Start and Connect to Services 

You should now start the services for the installed products. On Windows select the “Isode 
Service Configuration Tool”. 

In the Service Configuration GUI, ensure that all services are set to a Start Type of “Automatic”. 
Then select “Start All” from the Operations menu. Once your service configuration matches that 
in Image 14, you can close the service configuration GUI. 

Image 14: Service Configuration 

 

On Linux execute the following commands: 

# /etc/init.d/pp start 

Now return to MConsole and select “View > Live Operations > Switch Operations”. Dismiss the 
Error dialog box and right-click on the MTA with the Red “X” next to it (FIELD in this example) 
and select “Modify”. 

Image 15: Modify Message Switch 

 

In the Edit Message Switch screen, change the password to the one you created for the Initial 
Directory User “Messaging Admin” and click [OK]. 
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Image 16: Edit Message Switch 

 

Back in the main MConsole screen, right-click on the MTA again and select “Connect”. 

Image 17: MTA Connected 
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Create X.400 Mailboxes 

In MConsole, select “View > Configuration > X.400 Mailbox Management” and Expand the "Main 
Routing Tree" to your X.400 Address Space (/P=Local/A=Field/C=GB/). Then click on the Add P7 
Mailbox button.  

Image 18: Add P7 Mailbox 

 

In the screens that follow: 

• Choose the Address Form of “Personal Name” (Image 19) 

• Insert a Surname and Given Name (Image 20) 

• Confirm the O/R address (Image 21) 

• Ensure that a new White Pages entry is created for the User (Image 22) 

Image 19: Choose Address Form 
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Image 20: Set Surname and Given Name 

 
 
Image 21: Confirm O/R Address 

 
 
Image 22: Create a new White Pages Entry 

 

You should additionally: 

• Confirm the MTA and Message Store Details (Image 23) 
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• Set passwords for P7 Message Store and P3 Access (Image 24) 

Image 23: Confirm MTA and Message Store Details  

 
 
Image 24: Set Password 

 

Click on [Finish] and then repeat this process for an “user.two”. After adding both users, 
MConsole should display them as in Image 25. 

Image 25: Users Added 
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Testing with the Xuxa Demonstration User Agent 

We’re now going to use the Xuxa demonstration user agent (installed earlier with M-Switch) to 
test local messaging between the two users. 

Xuxa can only be connected to one account at a time, but can have several accounts configured, 
and one of them is always the default account. 

We’re going to log on as User One, making that the default account. We’ll then configure a 
second account, User Two, before exchanging messages between the two accounts to test the 
X.400 MTA. 

To start Xuxa on Windows, locate the Xuxa program icon. On Linux execute the following 
command: 

% /opt/isode/bin/xuxa 

After the introductory splash screen, in the White Pages Browser (Image 26) select User One, 
click [OK]. 

Image 26: White Pages Browser 

 

now enter the password set in the previous section and click [OK] again to log in to Xuxa as this 
user. You’ll be dropped into the main Xuxa GUI (Image 27) showing that you have successfully 
connected to the User One mailbox. 
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Image 27: Connected as User One 

 

We’re now going to configure the User Two account. Select “File > Preferences” from the Xuxa 
menu, highlight the Xuxa Accounts option and click on [Copy] to configure a new account using 
User One as a template. 

Image 28: Configuring User Two 

 

When prompted give the new account a name of “User Two” and click [OK]. In the Preferences 
screen (P7 Message Store), as shown in Image 29, make the following changes: 

• Change the Message Store User (O/R) field value to match that of User Two 
(/G=User/S=Two/PRMD=Local/ADMD=Field/C=GB/) 

• Change the Message Store User Password field value to match the password you set for 
User Two 

• Change the Message Store User DN field to match that of User Two (cn=User Two, 
cn=White Pages,o=Field) 

Click [Apply], then [Bind to the Message Store], then [OK]. 
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Image 29: User Two Preferences 

 

You’ll be dropped again, into the main Xuxa GUI this time showing that you have successfully 
connected to the User Two mailbox. 

Sending a Test Message between Users 
Now that both User accounts have been configured within Xuxa, you can send a test message, in 
this case from User Two to User One. Click on [Write] to bring up a new message screen (Image 
30). 

Image 30: Composing a New Message - 1  

 

Now click on the Address Book icon (below “From” in Image 30), select User One from the list 
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available addresses and click on [To] to add that address to the list of recipients. 

Image 31: Selecting a Recipient from the Address Book 

 

Click on [OK] to return to the message composition screen and add a Title and Message Content 
(Image 32) before clicking [Send]. 

Image 32: Composing a New Message – 2 

 

If you now click [Get Mail] in the User Two mailbox screen (Image 33), you’ll see that a Delivery 
Report has been generated for User Two, confirming that the message has been successfully 
delivered to User One. 
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Image 33: Delivery Report 

 

You can switch back to viewing the User One mailbox (File > Preferences, then select User One 
and click [Apply]) to view the received message from the perspective of the User One account. 
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Connect to an External X.400 System 

You have successfully set up an X.400 system for exchange of local messages, in the following 
(optional) parts of this document you’ll be guided through the process of connecting your system 
to an external X.400 system.  

For the purposes of this guide we have assumed that the external system is that 
which is set up as part of the “Setting up an SMTP/X.400 MIXER Gateway” guide. If 

you are connecting to a different system, please substitute connection details as 
appropriate. 

Create Remote User White Pages Entry using Sodium 
Xuxa does not support the "Free Typing" of recipient addresses, so in order to prepare Xuxa for 
sending messages to Remote User(s) you will need to add "White Pages" entries, for those users, 
using the Isode Directory Data entry tool "Sodium". 

To start Sodium on Windows locate the Sodium program Icon and select it. 

To start Sodium on Linux run the following command 

# /opt/isode/bin/sodium 

When Sodium starts you’ll be required to enter your Profile passphrase (which is the same as you 
used for MConsole) and then click [Connect] in the Bind Profile Management screen. 

In the main Sodium interface, expand the Directory Information Tree (DIT) until you find the 
existing white pages entries for your two existing users. The right-click on “cn=White Pages” and 
select “add Below” (Image 34). 

Image 34: Adding White Pages Entries 

 

In the Select template to add screen, choose “Person” and click [Next]. 

In the Select optional parts screen, tick “X.400 Messaging” and click [Next]. 

In the Enter RDN screen (Image 35), enter a description for this user before clicking [Finish]. 
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Image 35: Enter RDN of new entry 

 

Back in the main Sodium GUI, enter a surname for this new entry (“Headquarters” has been used 
in Image 36) and then in the Messaging Tab, (Image 33) click on [Edit] next to the OR Address 
field (Image 37). 

Image 36: Add Surname 

 
 
Image 37: Messaging 

 

In the O/R Address Editor field (Image 38), enter the O/R address of the user on the remote 
system, then click [OK] to return to the main Sodium screen and [Add] to finish adding this user 
to the white pages (Image 39). 
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Image 38: O/R Address Editor 

 

 

Image 39: User Added 

 

Create a Connection to an External X.400 MTA & Testing using MConsole 
First you need to add a Routing Tree entry for the Address Space of the External X.400 MTA, in 
this example this will be “/P=Local/A=Headquarters/C=GB/”. 

From the Switch Configuration Management view in MConsole right-click on the "Main 
Routing Tree" and select “Add Nodes”. 
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Image 40: MConsole – Create new Routing Tree Nodes 

 

Click [Next] through the Names and Domains screen and enter the details for the External MTA’s 
X.400 Address space in the O/R address hierarchy screen (Image 41) and click [Finish]. 

Image 41: Create New Routing Tree nodes – O/R address hierarchy 

 

You should now be able to see the new Headquarters node in the main routing tree (Image 42). 

Now right-click on “External Message Transfer Agents” and select “New External MTA”. 
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Image 42: New Routing Tree Node 

 

In the MTA type screen, select the “External X.400 MTA” radio button and click [Next]. 

In the MTA Naming screen (Image 43) enter the "MTA Name" of your External MTA and either 
the "Fully Qualified Hostname" or the IP Address of the External MTA. The "Directory Name" is 
free text and should be a name that is helpful for you to remember what the MTA is. 

Image 43: MTA Naming 

 

Click [Next] and in the Default O/R address prefix for the MTA screen, select the part of the 
routing tree you created earlier (PRMD=Local). 
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Image 44: Default O/R address prefix 

 

Click [Next] and enter the MTA Name and Password of your external MTA. 

Image 45: Remote X.400 MTA Auth Details 

 

Now click [Finish] to return to the main MConsole interface where you will now be able to see 
the external MTA you have created (under External Message Transfer Agents in Image 46). 

Now expand your MTA (FIELD), select the x400p1 channel and the “Auth” tab and, in turn, click 
on the [Edit] buttons next to “Initiator RTS Credentials” and “Responder RTS Credentials”. 
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Image 46: Authentication Requirements 

 

For both of these you’ll need to enter the MTA Name and MTA Password of your local MTA, in 
Image 47 the Initiator Credentials are shown, the Responder Credentials screen (not shown) 
should have the same values. 

Image 47: Initiator RTS Credentials 

 

After filling in both Initiator and Responder credentials, click on [Apply] in the Auth tab of 
MConsole to commit these changes. 

You can now test this connection by right-clicking on the x400p1 channel and selecting “Test 
Connection from this MTA”. 
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Image 48: Testing the Connection 

 

Select the newly created MTA from the drop-down list and click [Run Test] as in Image 49. 

Image 49: Run MTA Connection Test 

 

If you have followed the instruction carefully, you’ll see a successful test result (Image 50). 



Isode 

Evaluation Guide: Setting up an X.400 Email System  Page 30 of 32 

Image 50: Test Result 

 

Testing External Connections using the Xuxa Demonstration Agent 
You can also test the connection by sending an email to the remote user, following the 
instructions in the section Testing with the Xuxa Demonstration Agent and selecting the 
remote user, who should now appear in the white pages, as a recipient. 
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What Next? 

More information on M-Switch X.400, which can be deployed as a gateway/backbone or as an 
MTA to support local users, can be found on the Isode website at www.isode.com/products/m-
switch-x400.html.  

Information on the other Isode product used in this evaluation can also be found at: 

• M-Store: www.isode.com/products/m-store.html 

• Detailed configuration and operational information on all variations of M-Switch can be 
found in the three Administration Guides available for this product. 

1. M-Switch Admin Guide 

2. M-Switch Advanced Admin Guide 

3. M-Switch Operators Guide 

All of these documents, together with Admin Guides for all other Isode products can be found on 
the Isode website at www.isode.com/support/help.html. 

Other Evaluations 
This guide is one of four relating to Isode’s email messaging products: 

• Setting up an SMTP Email System  

• Setting up an X.400 Email System (this guide) 

• Setting up an SMTP/X.400 MIXER Gateway 

• Email for Constrained Network Environments 

Information on all of these evaluations can be found at www.isode.com/evaluate/evaluate-
email.html. For email evaluations outside of the scope of these guides, please contact us. 

Whitepapers 
Isode regularly publishes whitepapers on technical and market topics related to its products. A 
full list of these can be found at www.isode.com/whitepapers/. 
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Copyright 

The Isode Logo and Isode are trade and service marks of Isode Limited.  

All products and services mentioned in this document are identified by the trademarks or service 
marks of their respective companies or organizations, and Isode Limited disclaims any 
responsibility for specifying which marks are owned by which companies or organizations.  

Isode software is © copyright Isode Limited 2002-2018, All rights reserved.  

Isode software is a compilation of software of which Isode Limited is either the copyright holder 
or licensee. Acquisition and use of this software and related materials for any purpose requires a 
written licence agreement from Isode Limited, or a written licence from an organization licensed 
by Isode Limited to grant such a licence.  

This manual is © copyright Isode Limited 2018. 

 


